
                     

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Product Name 
 

Ceiling-Mounted Interactive Wall Projection 
 

2. Product Code 
 

22590 

 

3. Colour 
 

Not applicable 

 

4. Brief Description 
 

Imagine looking into a mirror and seeing yourself playing drums, splatting critters or tapping 
stars to change their colour and to make sounds. 

 

  

 



                     

 

 

5. Contents 
 

Quantity Component Notes 

1 3.5mm to 3.5mm Stereo Jack Plug 
Cable 1.2M 

PC Audio into Amp 

1 Projector & Wall Mount Ultra Short Throw Projector with wall 
bracket 

1 Loudspeaker Cable 10M 

1 Projector Fixing Kit Alternative fixing method for Projector 
if wall bracket is not suitable 

1 12V 1A, 2.1mm Power Supply Camera Power Supply 

2 1.5m IEC Cable  

1 DVI -D Single Link Cable (Male to 
Male) 2m 

From Graphics Card to Monitor 

1 10m SVGA Male to Male Cable From Graphics Card to Projector 

1 10m IEC Cable Projector Power 

1 10m BNC Cable Camera Video and Power 

1 BNC Socket to RCA Plug Connects Camera BNC Cable to 
Capture Card 

1 USB Video Capture Card Video Signal into PC 

1 IR Day Night Camera Camera used for motion tracking in 
this system 

1 19" Monitor (VESA 100x100) DVI Cable from PC into Monitor 

1 Dell USB Mouse Wired Mouse  

1 Dell USB Keyboard (qwerty) Wired Keyboard 

1 JBL Control 1 Speaker (White) Speakers that could be ceiling-
mounted of necessary) 

1 Software License  

1 Mini Amplifier Audio from PC  

1 VGA/DVI HDMI Low Profile Brackets  

1 Geforce Nvidia GT 740 2GB PCI-E with 
Low Profile Bracket 

Graphics Card - will be installed into PC 

1 Dell Optiplex 3040 PC  

 
 

  



                     

 

 

6. Snoezelen® Stimulations 
 
 Sight 

 Sound 
 

7. Best Use 
 
Use in a darkened environment. 
 

8. Compatible ROMPA® Products 
 
ROMPA® offers a wide range of multi-sensory products – please visit  www.rompa.com 
for more information. 

 

9. Starting Up 
 

 There are no short cuts when installing this product.  Please read all these 
instructions carefully. 

 

10. Detailed Description 
 

Imagine looking into a mirror and seeing yourself playing drums, splatting critters or tapping 
stars to change their colour and to make sounds.  A movement of the hand or a flick of a 
finger can trigger any number of audio-visual events around you.  Truly immersive, 
responsive and rewarding.  For individuals and groups.  Fully customisable. ROMPA® can 
install this for you – please contact us for information.   
 

11. Safety 
 

 Always supervise the use of this product 
 

 Use in a suitably clear space that is free of obstacles to allow users the opportunity 
to move freely. 

 

12. Technical Specification 
 

Size:   The projection is an aspect ratio of 4:3 
  The optimum projection size is between 1.5m to 2m wide 
  The optimum distance from the front of the projector to the wall is between 
   35cm and 45cm 
Weight: ceiling mounted components weight approximately 8kg 

http://www.rompa.com/


                     

 

 



                     

 

 

13. Installation 
 

1. Check you have all components before you begin – see your packing list. 
2. Assess cable routes and location for PC and monitor.  
3. Decide upon the location of the projector and the control area. 
4. Identify any wall imperfections e.g. indentations, skew that may distort the 

projection image. Even the slightest of curvature will alter the rectangular shape of 
the image. Please be aware of this when choosing a suitable location for the 
Interactive Wall Projection. 

5. Decide whether projector should be wall or ceiling mounted. 

 Wall mounted - use UST mounting bracket supplied with projector. Follow 
installation instructions in mounting bracket manual for installation and 
adjustment. 
 

 Ceiling mounted - use SG ceiling kit where you will have a steel wire for 600 x 
600 suspender ceiling or Z braces for plasterboard and concrete ceilings.   
To install the baseplate: 

 

 

 

 

 
 



                     

 

 

 

 
 
The Front Surface Mirror must be handled with care. 
Finger marks will damage the mirror coating and reduce the clarity of the projected image.  
Keep this covered until it has been mounted. 
 
 
 

 

 
 

 

 
 



                     

 

 

 

 
 
 
 

 

 
 
 

 

 
 



                     

 

 

 

 
 
 

 

 
 
 
 



                     

 

 

 

 
 

 

 
 
 

 

 
 



                     

 

 

 

 
 

 

 

 
 

 

 
 
 

 

 
 



                     

 

 

 

 
 
 
6. Determine whether amplifier should be mounted onto a rack, wall or free standing. 
 
Projector Installation 
1. To determine optimum projection size; turn projector on whilst it is on the floor to 

confirm distance from wall. 
2. Depending on your projection mounting solution, install the projector: 
 
For Wall Mounted Installation: 
Please follow the instructions in the wall mount manufacturers’ manual. 

 
For Steel Wire Installation: 
Please refer the instructions above for guidance on suspended ceiling install. 
 
For Z Brace Installation: 
Please refer the instructions above for guidance on Plaster/Concrete ceiling install. 

 

3. Once installed, turn projector on to see where the image is and adjust accordingly. At 
this point it does not need to be connected to the PC. 
 

4. Taking into account the projected image area, judge where the camera should be 
above the image. Make sure that the camera doesn't overlap the edge of the 



                     

 

 

projection image. 
 

5. Install the camera on the wall. 
 

Set up PC 
i. Insert USB capture card into USB port 

ii. Connect IEC cable to power socket 
iii. Connect the keyboard 
iv. Connect the monitor using the VGA cables 

 
Cables 
Please ensure all cabling is neat and tidy, using surface mounted conduit. 

 
 



                     

 

 

 
 

 
 
6. Cabling the amplifier 

i. 3.5mm jack to bare wire audio cable from PC (jack end) to amplifier. Bare wires 
connect to amplifier terminal block 

ii. Connect power supply to amplifier 
 

7. Cabling the Camera 
i. Connect camera to BNC power cable - power to red, video to yellow. 

ii. Connect 12v PSU to other red BNC power cable 
iii. Connect USB capture card to other yellow video cable 

 
8. Cabling the projector 

i. Run the VGA cable from the PC to the projector 
ii. Run IEC power to the projector 

Please note:  the VGA cable must be used for the Projector. 
 
9. Cable the monitor 

i. Run the DVI-D cable from the monitor to the PC graphics card.  



                     

 

 

Please note: In all MM installations the VGA output goes to the projector, the DVI-D output 
goes to the monitor. Never use HDMI.   
 
Powering up the system 
10. Connect the following power cables to a 6-way extension cable 

i. Projector IEC 
ii. Camera 12V 

iii. Monitor IEC 
iv. Amp  
v. PC IEC 

 
11. Connect extension cable to a power outlet in the room 
  
Test and configuration of the system 
12. Turn on PC, Camera, Monitor, Amplifier and Projector 

 
13. Run Magic Mirror software 

 
14. Check orientation of camera, you will see the cameras image in the software. When 

in front of the mirror, your left hand should move on the left side of the screen so 
you are fully mirrored. 
 

15. Check that the Magic Mirror is working when in the run time – To start run time, 
press the play button on the software's control panel and gesture into the projection 
to/make contact with an interactive object. If correctly configured, you will see an 
interaction and hear a sound. 

 
Using the Ceiling-Mounted Interactive Wall Projection 
 
There are a few things you need to familiarize yourself with before you attempt to turn the 
system on for the first time: 

1. PC and Monitor - this will usually be housed in a dedicated server rack or on a shelf close to 
the projector 

2. Projector - mounted on or above the ceiling and controlled by an IR remote control unit  
3. Amplifier - powers the speakers  

To begin with turn on the main power switch and make sure all equipment is in standby 
mode. You can tell that the equipment is in standby mode by checking the status of the 
standby LED's. 
 
Next switch the PC on using the button on the front of the PC. The Monitor will turn on 
automatically and you will see the Magic Mirror software begin to load. 
 
Note: if the Monitor doesn't come on, turn on using the Monitor's power button. 
 
Note: if the Magic Mirror software does not load automatically, locate the icon on the 



                     

 

 

Desktop and double click to run. 
 
Locate the Projector Remote and turn the projector on. When the projector warms up and 
shows the image it should display the Magic Mirror's output screen with the first app in the 
list visible. If you don't see this, but instead see the extended PC Desktop (as standard, this 
is a Sensory Guru logo), then this is most likely because the software is not running. Locate 
the icon on the Desktop and double click to run. If you see nothing at all, check the projector 
input is set to Computer 1. This is the button directly below the ON button of the Projector 
remote. 
 
The system is ready to use. Simply press Play on the Control Panel to activate. 
 
 
 
 
 
Once the system is powered on you can begin to use the apps 

 
 
Start by selecting the app you wish to use from the Scheduler (B). To do so simply click on an 
app name (such as Jack In The Box) with a single-click using the left mouse button. The app 
is now selected and should appear on your Projection wall. 

The next step is to activate the Magic Mirror. This is done by pressing the Play button on the 
Control Panel (D). 

The system is now active and ready for use. 

You may now switch between apps by simply clicking on the app name once (as above). The 
scene will change and be instantly ready for use. Elements may be freely moved around the 
screen by clicking anywhere on an their green boundary line (between the anchor points 
[the little white squares]) 



                     

 

 

Tip!  Be careful when moving elements, especially if there is a background image 
underneath. If you don't quite place the mouse on the boundary line, it may click through to 
the element below, moving that one instead! 

When you are finished using the system, close down the software by clicking the red box 
with the white cross at the top-right part of the screen (the same way most Windows 
applications are closed). If you have made any changes, a message will appear asking you if 
you would like to save them. Click "No" if you do not intend to keep changes or wish the 
system to be reset back to the default for the next use. 

 
 
To Create Your Own Apps 
Much like other computer programs, this system consists of a file (or a document) that can 
be worked on and saved.  The Apps in the Sequencer are simply layers within this 
document.  These layers are known as Levels in this system.   
For example, ‘Jack In The Box’ is on Level 1 whilst ‘Stars’ is on Level 2.  
When you click on ‘Stars’ whilst ‘Jack In The Box’ is open, you are simply switching between 
these levels. 
 
Start a new file. 
Open the Magic Mirror. 
Click ‘File’ from the very top tool bar and select ‘New’. 
 

 
 
You will now have a fresh file to work with.  
 
Save this new file. Click File>Save As. When the Save As browsing window appears, navigate 
to the Magic Mirror folder (C:\Program Files\Magic Mirror\) and look for the folder named 
"Settings". Give your file a unique memorable name and click Save 
 



                     

 

 

 
 
Note: the software, once opened, will load the default file (MagicMirrorMaster.Cfg). To load 
your own file, click File>Load - or Crtl+O and navigate to the Settings folder. Open the 
Settings folder, locate your file and click Open. 
 

 
 
From the Elements panel under the Create column, click "Field". You will notice a small Field 
Element appear on the Working Monitor and a green square followed by a number (the 
Level) and the work Dyn (which is short for Dynamic Field Element). 
 



                     

 

 

 
 

To make the new element easier to work with, click the bottom-right anchor point and drag 
to make it larger. 
 

 
 
Now move the element. It is a good idea to do this now, as any further elements created will 
appear in this area so will be overlapped and tricky to get to. Click on a boundary line 
anywhere between the anchor points and drag to move (like drag and dropping items on 
your desktop!). 
 



                     

 

 

 
 
Move up to the Elements panel and click on the More tab (under the Properties column). 
 

 
 

Click the "Def Glyph" Brose button and locate the image you wish to use. In this case, the image 
"PinkFlower.png". Do the same for "Trig Glyph" but this time, select the image "RedFlower.png". 
The two options will now show the image files that have been loaded, like this: 
 

 



                     

 

 

 
 

If you don't see any images where you would expect to find them, click on the drop list for 
"Files of type:" at the bottom of the Browse window and select "all files": 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you wish, you may test your progress by moving down to the Control Panel and pressing 
the Play button. Move over your element to see it triggered and the second image 
displayed: 

 
 
The next step would be to add some sound. Move back up to the Elements panel and click 
the Samples tab under the Properties column. 



                     

 

 

 

 
 
Click "New" and locate the file "HarpBloom.wav". Once loaded, the Samples tab will now 
show the file, like this: 

 
 
Again, if you do not see the sound file you are looking for, click on the drop list for "Files of 
type:" at the bottom of the Browse window and select "all files" (as above). 

Test your progress once again to hear the sound now accompanies the image change when 
triggered. 

Cast your mind back to the start of this tutorial, in the Elements List that contains 
information about the element. The number 1 is significant because it is the Level at which 
the element resides. 

In order to make this work an app in its own right, let's give the app a name! 



                     

 

 

This is done with a small and simple piece of code typed into the Sequencer: 

 

Notice that "Run" is highlighted. Also note the large white box below. 

Click "Edit" and you will see that the large white box becomes editable: 

 

In the large white box, we are going to type some words that will signify our element's Level 
as an "app". 

Before we do so however, we will need to type a piece of code that will initiate the process. 
This is because we are working on a new file for the first time. Once this is entered, it need 
not be done for this app again, the following code is a two part command to tell the 
software to produce a secondary monitor ie; the Projected image (the "MO" part) and take 
a snap shot of the background for optimum use (the "BK" part) 

The one-off code to type here is: "MO+ BK" 



                     

 

 

 

While we still have the Sequencer in edit mode, we may as well type the next part of code. 
The following code is required for each app you wish to create: 

G1 = Name of app 

where "G1" refers to the element. In this case G stands for "green" (the default colour given 
to an element when created. This need not be changed for these purposes)and the number 
1 stands for "Level 1". And "Name of app" is your chosen name for the app you wish to 
create. 

We need to type this new code on a new line. So, make sure the Sequencer is in edit mode, 
click immediately after MO+ BK and press return to enter a new line. 

Type "G1 = Flower". Keep the Sequencer in edit mode for now 

 

Let's type the code for the next app. Even though we have not yet created any content for 
it, it is a good idea to get this part done now as when the new app is selected, the next Level 
will automatically be selected for us to work on! 



                     

 

 

Again, go to the end of the previous line (in this case to the end of "G1 = Flower") and press 
return. 

Type in the following: 

"G2 = Dog" 

This creates a new Level for our new app! 

 

Now click Run. 

Test your progress by now clicking on the next app. To do so, simply move the mouse cursor 
over the line that says "G2 = Dog" in the Sequencer and sing-click it. 

You should notice that the flower of the first app disappears. This is because we are 
switching to Level 2 (the next app). Let's put some content on it! 

With the Dog app selected, create a new Field Element (as above). As before, move to the 
More tab in the Elements panel. For Default Glyph load the file "Dog1.png". For the 
Triggered Glyph, load "Dog2.png". Under the Samples tab, load the file "DogBark.wav". 

You now have two apps! 

Note: If you would like to add to either of your apps, simply select the app you wish to add 
to (by clicking on its name in the Sequencer) and create new elements as desired. Any new 
elements created will be created on the same Level hence they will all be a part of that app. 

If you want to create a new app, first enter the new app's code as we did for app 2, click Run 
and with the newly created app selected, go about creating new Elements. 

You will need to save any changes you make, if you wish to keep them, each time you close 
the software. 



                     

 

 

14. Care and Maintenance 
 

1. Clear the projector filters every 3 to 6 months depending on use.  
2. Change the projector lamp as required using a new lamp of the same specification. 

 

15. Troubleshooting 
 
In the unlikely event of product failure, please check the following: 
 

Problem: Incorrect camera settings 

• Amcap is a program used to configure a camera connected via composite connection. For 

example; the cameras used by the Magic Mirror system. Amcap can be opened by double 

clicking the Desktop shortcut icon if one has been created. If there is no shortcut icon, you 

can find Amcap here: C:\Program Files\Magic Mirror\tools\ 

Once open you will be presented with the main interface. Note, that if the camera is 

plugged in and set up correctly, you will see the camera image. If not, then there will be 

either a complete black or white image instead. 

 Locate the "Options" menu at the top 

 
 
The Options menu contains some further options: "Video Capture Filter", Video Capture 
Pin" and depending on what version of the software you are running, you may have "Video 
Crossbar": 



                     

 

 

 
 

From the Options menu, select "Video Capture Filter". Look at the Video Decoder tab and 
make sure the Video Standard option is set to "PAL_B". Click "Apply" and then "Ok" to exit. 

 
 

Next, select "Video Capture Pin". Video Standard should automatically be set to "PAL_B" 
having just set that in the capture filter panel. Set the Frame Rate to "25.000" and Make 
sure the Output Size is set to "704 x 576". Click "Apply" and then "OK" to exit. 
 



                     

 

 

 
Finally, (if your version shows it) select "Video Crossbar". In the first section, Input, select "1: 
Video Composite In". Click "Apply" and then "OK" to exit. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



                     

 

 

If your camera is correctly connected and powered, with these settings, you should now see 

an image in Amcap. 

Close Amcap. 

  

Note: Make sure Amcap is correctly configured and CLOSED before starting the Magic 

Mirror software. There will be a conflict and subsequent error message if trying to run the 

Magic Mirror and Amcap together. 

 
 
Problem: System not responding to interaction or intermittent interaction 
 
Make sure you have pressed Play on the Control Panel to ensure the Magic Mirror is active. 
If you are finding your Interactive Field Element to be unresponsive or too sensitive, try 
adjusting the settings to suit. This may occur in very low/very high ambient light situations 
or where the environment allows for direct sunlight or concentrated light in certain areas 
around the room. For example; one of your elements is sitting right over a bright window. 

Sensitivity, Threshold and Filter settings (Elements panel > Fields column) 

Sensitivty and threshold work together to set a Field Element's overall sensitivity; 

 
Sensitivity relates to movement. The higher the sensitivity value the more easily the 
element will detect movement. For example; the sensitivity is set high, the element detects 
even the slightest of movement from a wiggling finger. 

 
Threshold relates to a value at which the element will trigger. Even though the element is 
set to a high sensitivity level and is detecting the movement from the wiggling finger, the 
element has not yet triggered. It will not trigger until the finger movement becomes more 
prominent and breaks through the threshold value. In this case, it is necassary to either 
reduce the threshold level, or increase physical movement to trigger the element. 

The Filter option determines how quickly the Field Element resets after being triggered. For 
example; if increased in value, the triggered event will linger for longer. 

If the value is very low or set to zero, the element will reset itself almost instantly after 
being triggered. If the Filter is set in this way, you may experience a 'bouncing' trigger event. 
This is where the element is triggered, resets very fast and triggers instantly producing a 
bouncing effect. To reduce this effect you may set the Debounce value a little higher (the 



                     

 

 

Debounce setting is to the left under the Options column). A value of around 2 will redcuce 
this unwanted effect sufficiently for most situations. Unless of course, that's the effect you 
are looking for! 

 

The camera supplied with this system is powered by a 12V Power Supply. If you are 
experiencing problems with connectivity or the system appears to be unresponsive to user 
interaction, check that the LED array on the camera is glowing red as shown below. If not, 
then it is likely that the Camera is either unplugged or turned off. Rule this out first before 
following the next series of steps! 
  

When you are sure that the Power Supply is turned on and all connections are good we 
need to determine whether the issue is with the Power Supply or the Camera, locate an 
alternative 12V PSU 1A 2.1mm DC Plug and connect to the system - please contact us. 

 

 
Problem: No sound 
 
Before proceeding with troubleshooting sound, make sure the PC has not been muted. Also 
make sure you have pressed Play on the Control Panel to ensure the Magic Mirror is active. 
Navigate to the bottom right of the Desktop screen and locate the speaker icon (within the 
toolbar). Click it to reveal the volume slider. Adjust as required. 
 
If you have a fixed installation, your system will be connected to either an amplifier or an 
existing sound system. Locate the amplifier. If it is a Nuvo amplifier (small white unit), make 
sure it is on by slowly turning the volume knob to the right (turned fully left will turn the 
amp off). 
 
If you have a black Cambridge Audio amplifier, make sure the volume knob is turn up 
sufficiently (but not too high!). Make sure the source selector is set to the correct source. 



                     

 

 

This is usually 'CD' or 'MP3' depending on your setup. If either of the do not work, try slowly 
selecting each source until the sound comes on.  If your system is connected to your own 
sound setup, check that you have it set correctly 
 
 
Problem: I can't see a computer image displayed through the Projector? 
 
This is a very common issue people experience when operating projectors, which can 
usually be rectified very quickly. Most projectors have multiple input sources to make it 
possible to connect more than one PC or video device.  If you have turned on both the PC & 
Projector, and the Projector displays an image like the one below (image varies depending 
on the make and model, but all have a version of this) it is likely that a different image 
source has been selected. 
 

 
Solving this issue is usually as simple as selecting the correct source from the remote 
control. All Magic Mirror systems will be set to display on Computer 1 or Computer 2. 

 
Very occasionally the issue may have a different cause. If someone has accessed the rear of 
the PC or needed to access the ceiling near the Projector, it is possible that the VGA Cable 
has been disconnected from the PC or the Projector. Please see articles relating to Magic 
Carpet component list for more info. 



                     

 

 

 
 

 

Further copies of these instructions can be downloaded at www.rompa.com 

We hope you find our instructions invaluable.  If you have any suggestions for improving 
them further your comments will be greatly received – please contact us at 
producthelp@rompa.com 
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